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Introduction

This tutorial introduces you to the basics of Mastercam Mill-Turn. Mill-Turn is a large
product with several components, each of which is covered in this tutorial. When you
have completed the lessons included in this tutorial, you should have the knowledge
you need to get started with this versatile product.

Tutorial Goals
l Become familiar with the Mill-Turn components.

l Learn the main differences between Mastercam Lathe and Mastercam Mill-
Turn.

l Know the Mill-Turn work flow.

l Explore the contents and use of machine files.

l Understand tool setup and reference positions.

l Setup a Mill-Turn job.

l Create turning and milling toolpaths.

l Use Sync Manager and Machine Simulation effectively.

l Load tools into multi-station tool locators.

WARNING: Screen colors in the tutorial pictures were modified to enhance
image quality; they may not match your Mastercam settings or the tutorial
results. These color differences do not affect the lesson or your results.

Estimated time to complete this tutorial: 8 hours

Mastercam Mill-Turn Tutorial — Introduction



General Tutorial Requirements
All Mastercam 2018 tutorials have the following general requirements:

l You must be comfortable using the Windows® operation system.

l The tutorials cannot be used with Mastercam Demo/Home Learning Edition.
The Demo/HLE file format (emcam) is different from Mastercam (mcam), and
basic Mastercam functions, such as file conversions and posting, are unavail-
able.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's
skills. We recommend that you complete them in order.

l Additional files may accompany a tutorial. Unless the tutorial provides specific
instructions on where to place these files, store them in a folder that can be
access from the Mastercam 2018 workstation, either with the tutorial or in any
location that you prefer.

l You will need an internet connection to view videos that are referenced in the
tutorials. All videos can be found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a
default metric or English configuration. The tutorial provides instructions for
loading the appropriate configuration file.

Mastercam Mill-Turn Tutorial — Introduction
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Introduction to Mill-Turn

This tutorial presents an overview of Mastercam Mill-Turn and teaches the
basics of preparing, simulating, and posting a Mill-Turn part. Along the way,
you learn about the applications that make up Mill-Turn, including not only
Mastercam, but also Code Expert.

Lesson Goals
l Understand the applications that make up Mill-Turn.

l Prepare the tutorial files.

l Learn how to load machine files.

1



What is Mastercam Mill-Turn?
Mastercam Mill-Turn is a collection of functions, toolpaths, and applications. These
Mill-Turn elements work together to create synchronized G-code for cutting parts on a
multitasking machine.

You begin the Mill-Turn work flow in Mastercam, where you load or create the part to
cut. You then load a Mill-Turn machine, which adds Mill-Turn operations to Master-
cam’s interface (see the following picture). These operations include not only milling
and turning toolpaths, such as facing, pocketing, and pinch-turn, but also part-hand-
ling operations for programming pickoffs, cutoffs, bar feeds, spindle movement, and
more.

Mastercam Mill-Turn Tutorial — 1: Introduction to Mill-Turn
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When you have designed and toolpathed your part, you continue work in Code Expert,
which is home to sync manager, editor, and it is also where you launch MT simulation.
In Sync Manager you synchronize operations, in Editor you edit NC files, and in
Machine Simulation, you watch your operations in action.

System Requirements
Up-to-date system requirements are available for Mastercam online: www.-
mastercam.com/en-us/Support/System-Requirements.

An internet connection and e-mail access is recommended for support and updates.
Visit www.mastercam.com for more information.

Getting Ready to Work
Now that you know what Mill-Turn can do, it is time to prepare your materials for the
remainder of the tutorial.

Preparing the Files
1. Place the part files included with this tutorial in a convenient location on your

hard drive.

2. Place a copy of Generic Fanuc Mill-Turn LTX.machine (also
included with this tutorial) in your C:\User-
s\Public\Documents\shared Mcam2018\Mill Turn\machines
directory.

Mastercam Mill-Turn Tutorial — 1: Introduction to Mill-Turn
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Loading a Missing Machine File
Mill-Turn part files store a reference to their machine file. If the machine file is miss-
ing or moved, Mastercam asks you to re-associate the machine with the part. The fol-
lowing procedure shows how to complete this important task. (You do not need to do
this now. You only need to do this if your part cannot find its machine file.)

1. Open the part file with Mastercam.

The MT Machine File Missing dialog box appears, as seen below.

2. Click Yes.

The MT Machine Files dialog box appears.

3. Navigate to the machine file for your part (in the case of this tutorial, the
machine file is Generic Fanuc Mill-Turn LTX.machine), and select
it.

Code expert loads the machine file associated with the part file.

4. Optional : Save the part file under a new name, so that you do not overwrite
the original.

How the Tutorial is Organized
This tutorial’s lessons introduce the concepts, applications, and work flow that make
up Mastercam Mill-Turn. Because the exercises in each lesson are meant to be com-

Mastercam Mill-Turn Tutorial — 1: Introduction to Mill-Turn
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pleted in order, we highly recommend that you work through this tutorial from the
beginning to the end rather than skip from one lesson or tutorial to another.

The following list describes each of this tutorial’s lessons:

Lesson 1, Introduction to Mill-Turn introduces the Mill-Turn product and offers
guidelines for using this tutorial.

Lesson 2, Transitioning to Mill-Turn from Lathe describes the differences between
Mastercam Mill-Turn and Mastercam Lathe, including network issues, file com-
patibility, and user-interface changes.

Lesson 3, Workflow Overview is a general road map for successfully working with
Mastercam Mill-Turn. Topics covered include part geometry, Mill-Turn machine solu-
tions, job setup, toolpaths, and more.

Lesson 4, Working with Machine Files, describes how to install, edit, and customize
machine files, as well as how to configure Code Expert Editor and manage Mill-Turn
licenses.

Lesson 5, Working with Tools and Spindles, explains how to set up tools and spe-
cify axis combinations.

Lesson 6, Reference Positions demonstrates how to create and use reference pos-
itions to specify where to start and end operations.

Lesson 7, Configuration and Job Setup presents detailed exercises for preparing a
Mill-Turn part, including specifying a machine and completing job setup.

Lesson 8, Turning Toolpaths features step-by-step procedures for creating and syn-
chronizing turning toolpaths and part-handling operations on the left and right
spindles of your machine.

Lesson 9, Milling Toolpaths features step-by-step procedures for creating and syn-
chronizing milling operations, including facing, pocketing, and contour toolpaths.

Mastercam Mill-Turn Tutorial — 1: Introduction to Mill-Turn



Lesson 10, More about Sync Manager provides an overview of Sync Manager’s user
interface and functionality. This lesson also includes a discussion of Sync Manager’s
interaction with Mastercam.

Lesson 11, More about Machine Simulation provides an overview of Machine Sim-
ulation’s user interface and functionality.

Lesson 12, Posting is an overview of Code Expert Editor, including posting, editing,
and navigating an NC file. This lesson also presents a procedure for sending a file to a
machine control.

Lesson 13, Loading Multi-Station Tool Locators describes how to load tool locators
onto a machine’s turrets, as well as load tools into the multi-station locators. The com-
plete sample program demonstrates many tool locator and tool combinations.

Mastercam Mill-Turn Tutorial — 1: Introduction to Mill-Turn
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Transitioning to Mill-Turn from Lathe

Before you start work with Mill-Turn, you must understand how it differs
from pre-X7 Mastercam. This lesson provides the information you need to
begin using Mill-Turn effectively.

Lesson Goals
l Use a machine on a network.

l Update Lathe parameters.

l Understand changes in the menus.

l Review changes in Toolpaths Manager.

l Explore communication settings.

2



Running Over a Network
A machine solution (represented by a MACHINE file) includes the post processor and
other files that Mastercam needs to run Mill-Turn. This means that managing Mill-
Turn over a network is simplified. Because Mastercam can access the machine file
from any network location, you can move the file where you wish. You do not need to
worry about the links between the machine solution’s components.

When you load a Mill-Turn part, Mastercam looks for the machine file and reloads it. If
the machine solution’s machine file cannot be found—either because it has been
moved or renamed—you are prompted to find and select it. This interaction is dif-
ferent from earlier versions of Mastercam, which do not look for the machine defin-
ition when you load your part, but relies on the copy stored in your part file. Mill-Turn
requires that your machine file be available whenever you open your part. This
ensures that if your machine file (or post) has changed, your part will stay up-to-date.

Replacement of Parameters that Differ in Mill-Turn
Many options on the Lathe Toolpath parameters dialog box (highlighted in this pic-
ture) are not present in Mill-Turn:

The following picture shows the same dialog box in Mill-Turn:

In Mill-Turn, these functions are all machine-specific features that are configured in
the machine file.

l Coolant options are selected in Sync Manager. Instead of selecting individual
options, you select strategies that combine several different coolant events.
Your machine developer defines these strategies based on options that are
available on your machine.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe
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l Mastercam reads home positions from the machine file. You select approach
and retract strategies in Sync Manager.

l Misc values and canned text do not exist in Mill-Turn. You access machine-spe-
cific options and parameters in Sync Manager.

The following picture shows how coolant appears in Sync Manager. Click the small
inverted triangle next to each operation or segment to see what options are available.

Unlike Lathe, where you are limited to 20 miscellaneous ints and reals, Mill-Turn has
no limit on the number of machine-specific options. Plus, the options can be specific to
individual operation types or parts of an operation. Also, while the previous misc val-
ues are limited to numbers, toolpath options in Mill-Turn can be presented as num-
bers, checkboxes, list selections, or strings.

Menu Changes
Mill-Turn organizes the single Toolpaths menu from older versions of Lathe into dif-
ferent contextual tabs, as follows:

l The Turning tab contains Lathe operations, including part handling (formerly
Misc Ops).

l The Milling tab contains 2D, 3D, and Multiaxis Mill operations.

In addition, the Machine Definition Manager and Control Definition Manager are dis-
abled. You can access many of their settings in Mill-Turn by opening the machine file
in Code Expert, and double-clicking Consumer in Machine Explorer.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe



Toolpaths Manager Changes
The Toolpaths Manager for Mill-Turn operations has important differences from that
with non-Mill-Turn operations.

Toolbar Functions
The Tool Setup button on the Toolpaths Manager toolbar is used exclusively by Mill-
Turn, whereas the G1 button has a new function in Mill-Turn:

The Tool Setup button lets you configure how tools are loaded on your machine.

The G1 button opens Sync Manager (only in Mill-Turn). From Sync Manager, you can
create syncs, configure toolpath options, post operations, and launch Simulation.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe
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Machine Group Properties (Files tab)
Some options in the Files tab have been removed for Mill-Turn users, since Mill-Turn
stores the individual support files in the machine file.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe



l Although a default tool library is stored in the machine file, you can still select a
different one here.

l When creating individual operations, you can always select a tool from any lib-
rary, just like in Mill and Lathe.

l You can also import operations from any library, just like in Mill and Lathe. The
operations library listed on this tab is only a default selection.

While in non-Mill-Turn Mastercam, you can use the Replace button to select a dif-
ferent machine definition, in Mill-Turn you cannot do this. You can, however, use the
Edit button to make changes to the current machine, if necessary.

Machine Group Properties (Job Setup tab)
The Job Setup tab is new for Mill-Turn. It replaces the Stock Setup tab from Master-
cam and is available only in Mill-Turn.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe
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Although the Job Setup tab seems to recreate much of the functionality of the Stock
Setup tab in Lathe, it is more closely tied to your work flow.

Follow this general work flow when creating your parts:

1. Create your part geometry. The Mill-Turn work flow proceeds more smoothly
if you minimize later changes to your part.

2. Create a solid model of your finished part. A solid model is not required,
but if you have one, the Machine Simulation and Sync Manager functions dis-
play it with your toolpaths.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe



3. Select your machine file from the Machine tab. The Job Setup function
launches automatically.

4. Complete the Job Setup pages in the order presented.

When you complete Job Setup, Mastercam automatically creates resources that help
you program your part. The following list describes these resources.

l A customWCS—This is a copy of WCS Top, whose origin is located at the
machine zero location from your machine file.

l New views within the WCS—These views correspond to standard machining ori-
entations and applications, for programming both left and right spindles. Each
view is created with the proper origin and work offset from your Job Setup set-
tings. For example, in Job Setup you can choose to locate Z0 at either the front
face or back face of your part; Mastercam then automatically creates tool
planes with the desired origin.

l Viewsheets for each spindle—Each viewsheet contains a copy of the part geo-
metry properly positioned relative to the chuck jaws.

You learn much more about the individual Job Setup pages when you complete the
exercises later in this tutorial.

Communications
In Mill-Turn, you use Code Expert to configure your communications settings.

1. Open Code Expert from your Start menu (Start, All Programs, Mastercam
2018, Code Expert). If you already have a Mill-Turn machine loaded, Code
Expert will already be open.

2. Select Options from the File tab.

3. Select Editor, NC, Communications.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe
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4. Set your options as desired. Use Help to learn more.

Mill-Turn uses the same XML-based configuration files as previous Mastercam ver-
sions, so if you have been using a customized file, you can use it in Mill-Turn. You can
also use the same communications program.

Mastercam Mill-Turn Tutorial — 2: Transitioning to Mill-Turn from Lathe
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Work Flow Overview

Mastercam Mill-Turn introduces a streamlined work flow for creating the
operations to cut your part. This lesson presents an overview of this work
flow. The following lessons provide more detail and hands-on exercises.

The Mill-Turn work flow comprises the following steps. The remainder of this
lesson explains each step in more detail.

Lesson Goals
l Load or create part geometry

l Load the appropriate machine

l Complete job setup

l Create toolpath operations

l Create part handling operations

l Synchronize the operations

l Simulate the operations

l Post the operations

3



Load or Create Part Geometry
Your first step with Mill-Turn is to create your part’s geometry. Often, this means
simply loading the part’s file, although you can use Mastercam’s CAD tools to create
the part’s geometry or to modify an existing part.

Load the Appropriate Machine
Before you can create Mill-Turn operations on your part, you must load a Mill-Turn
machine. Choose Machine, Mill-Turn, and then select the machine file you need.

The machine file is a group of files stored as a unit. These files include the machine
definition, tool database, and other data that non-Mill-Turn Mastercam stores in sep-
arate files.

Complete Job Setup
When you choose a Mill-Turn machine, Mastercam not only loads the machine, but
also starts Code Expert, in which you complete many Mill-Turn tasks.

After the machine file and Code Expert load, Mastercam displays the Job Setup tab of
the Machine Group Properties dialog box. (You can also open Job Setup at any time
from the Toolpaths Manager, as shown below.) This tab is where you define the gen-
eral parameters for your job. Job Setup arranges these parameters in work flow order
from top to bottom. The following sections describe each page of parameters.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Setup Type Page
Use this page to set the spindle on which your job will begin. Here, you also specify
your stock type (either continuous bar or single piece) and how to handle the parts as
they are created. Stock type determines which part handling operations—such as pick-
offs, cutoffs, and stock pulls—are available.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview



WCS Page
Use this page to define your Work Coordinate System (WCS) by clicking the Select
Named Plane button (circled in the image below) and choosing the initial WCS from
the Plane Selection dialog box. Use the WCS option when importing geometry that is
aligned incorrectly for machining, orienting the part on the machine differently from
how it is oriented in Mastercam. On this page, you can also change the machine
group’s name, which appears in the Toolpaths Manager.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Part Geometry Page
Use this page to select your part geometry and tell Mastercam how to create geo-
metry for the other spindle or for a turn profile. You can also select the color and spe-
cify the levels on which Mastercam creates the geometry.

If Create Right Spindle Geometry is selected, Mill-Turn creates the part geometry
in both spindles. If Create Right Spindle Geometry is off, Mill-Turn shows the part
geometry in only the starting spindle. Having the part geometry in both spindles lets
you program the part on both the starting and opposing spindles.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview



Bar Stock Page
Use this page to select the type of stock and its dimensions. You can also specify the
number of parts to create and the amount of material to leave for other operations.
Extra face and back stock are commonly used to leave stock for facing operations and
affect the part transfer cutoff positions.

Note: Mill-Turn supports different stock types, with the stock page changing depend-
ing on your setup type.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Chuck Jaws Page (Left and Right Spindles)
Use these pages to set chuck parameters for each spindle, including the clamping
method, chuck dimensions, and part stickout.

Toolplane Origin Z Page (Left and Right Spindles)
The Toolplane origin sets the zero point for operations on each spindle. Mastercam
can calculate the value from the part geometry, or you can enter it yourself.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview



StickOut Page
Use this page to specify how much of the part sticks out from the face or jaws of the
spindle. You can enter the values manually or choose a location in the graphics win-
dow.

Pickoff Page
Use this page to set pickoff and cutoff parameters. These include the pickoff location,
the cutoff tool, and the cutoff width. Note that Mill-Turn uses the cutoff width to adjust
the cutoff positions.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Finishing Job Setup
When you have finished setting up your job, click OK in Job Setup to finalize your
choices. Mastercam creates your machine group, plus a set of convenient resources:

l The new WCS

l Viewsheets for each spindle

l Default toolplanes

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview



The viewsheets, subspindle geometry, and the revolved part profile make it easy for
you to program operations on the subspindle.

Mastercam creates planes that correspond to standard machining orientations for dif-
ferent types of operations in each spindle, with origins keyed to the locations that you
selected on the Job Setup pages.

Create Toolpath Operations
With job setup completed, you can create the operations to cut your part. Choose
between turning and milling operations, each tab having its own galleries in Master-
cam’s Mill-Turn tab. (Note that this tab appears only when you have loaded a Mill-Turn
machine file.)

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Creating an operation means choosing not only a specific toolpath, such as facing or
roughing, but also providing information about how your machine will perform the
operation. For example, as part of the toolpath operation, you choose the cutting tool
and specify the axis combination (the pairing of a spindle and a turret).

Create Part-Handling Operations
Next, you tell Mastercam how to handle the part using pickoff and cutoff operations.
You choose these transfer operations from Mastercam’s Part Handling functions on
the Turning tab, whose available operations depend on the type of stock you have spe-
cified. For example, single-piece stock requires only a pickoff, whereas continuous bar
stock requires a cutoff and a pickoff. The part handling functions also include such
operations as bar feeds, stock pulls, and turret parking.

Note that part-handling operations are not limited to finished parts. They can be used
for many reasons, including bar feeding, pickoff ops where the opposing spindle sup-
ports the part, and other custom routines written by the machine solution provider.

The Pickoff, Cutoff, and Stock Pull operations are complete strategies with predefined
lists of sub-operations, relieving you from having to create these sub-operations one
by one, although you can modify them as needed. Choosing one of these strategies
adds a group of operations to Mastercam’s Toolpaths Manager.

The resulting operations in the part handling group cannot be moved or deleted indi-
vidually; the entire group must be deleted. This restriction allows the machine solution
provider to code the post logic to handle operations in specific fashions required by
the machine tool.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview



Synchronize the Operations
Sync Manager is a visual tool that creates sync points for multi-stream machines. It
also helps you create—for both single- and multi-stream machines—custom job
setups that ensure valid output.

Synchronizing Multi-Stream Jobs
After you create your operations in Mastercam, run Sync Manager (shown in the fol-
lowing picture) from the Toolpaths Manager, and synchronize the operations on your
machine. Use your mouse to drag-and-drop operations between streams to ensure
that each can complete successfully without collisions or other problems.

Customizing Settings
Sync Manager provides access to many settings, including coolant strategies, ref-
erence positions, and options traditionally stored as misc values in previous Master-
cam versions. You can modify these settings by clicking the arrow associated with the
option to change, and typing the required values into the provided fields.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Simulate the Operations
Use Mill-Turn to simulate the machine’s motions as it cuts your part. By zooming or
setting the visibility of specific components, you can customize the view to your needs.
For example, the first picture below shows Machine Simulation’s display in isometric
view, and the second picture shows the same job with the machine housing turned off.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview



Post the Operations
When you have validated your job, you post the operations, which creates the G-code
that you send to your machine to cut the part. After it is generated, the G-code dis-
plays in the editor, from which you can access the communications functions needed
to transmit the code to your machine.

Mastercam Mill-Turn Tutorial — 3: Work Flow Overview
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Working with Machine Files

This lesson provides basic information on working with machine files, which
drive your entire Mill-Turn experience. A Mill-Turn machine file (which has
the MACHINE extension) differs from the machine and control definition files
used in non-Mill-Turn Mastercam.

Lesson Goals
l Installing your machine file

l Customizing your machine file

l Customizing operation defaults and tool libraries

l Editing machine file settings and defaults

l Configuring Code Expert Editor

l Setting the toolpath directory

l Managing machine licenses

4



Installing Your Machine File
Your machine file is packaged in a ZIP file with the PDF version of the machine’s
application guide. Simply unzip the machine file to your desired location. The default
location is \shared Mcam2018\Mill Turn\MACHINES. However, you can place
the machine file anywhere you wish.

Unlike non-Mill-Turn Mastercam machines, a Mill-Turn machine file includes all the
resources needed to support your machine application. That is, the machine file does
not need to link to other files, such as posts.

To work with your machine file from a network location, copy it to the desired location
on your network. Since the machine file points to no other files, it works the same
from a network location or from a local drive.

Note, however, that Mastercam looks for the machine file when you load a part that
uses it, so the machine file must be in a location to which your workstation regularly
connects.

Note: This guide comes with generic machine files that you can use to try Mill-Turn.
You use one of them throughout this tutorial. If you wish, you can experiment with the
others.

Customizing Your Machine File
When you load your machine file in Mastercam, Mastercam also loads the machine
file into Code Expert. When you switch to the Code Expert window and show Machine
Explorer, you can see the components of your machine file, as described below:

Mastercam Mill-Turn Tutorial — 4: Working with Machine Files
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The Control Layers section lists the resources the post uses. Most of these resources
are hidden by the post/machine developer. However, the Consumer layer contains
machine defaults and other settings that you, as a user, can edit.

The Mastercam Files section lists support files that are encapsulated inside the your
machine file. In non-Mill-Turn Mastercam, these support files are stored throughout
your Mastercam installation; Mill-Turn brings them together inside the machine file.

The files in the Mastercam Files section are disabled because you cannot edit them
in Code Expert. However, you can edit common files such as your operation defaults,
operation libraries, and tool libraries inside Mastercam. To do this, follow the
guidelines in the next section.
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Customizing Operation Defaults and Tool Libraries
You can follow this procedure as needed to customize operation defaults and tool lib-
raries. (You do not need to do this as part of the tutorial.)

1. Start Mastercam.

2. Load your machine file or a part that uses the machine file.

3. In Toolpaths Manager, click the Files icon in the Properties section.

The Machine Group Properties dialog box opens with the Files tab selected.

4. In the Tool Library section, use the tool editing buttons to make needed tool
library changes.

5. In the Operations Library / Defaults File section, use the edit buttons to
make needed operation and defaults changes.
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6. Click the green check to accept your changes and exit the Machine Group
Properties dialog box.

Note: You can also make changes using the Toolpaths Parameters page in any
operation.

7. Switch to Code Expert and notice that your changed file is marked with an aster-
isk in Machine Explorer.

8. In Code Expert, click in Machine Explorer to give it the focus, and then press
[Ctrl+S] to save your machine changes.

Editing Machine File Settings and Defaults
Your Reseller typically supplies your machine file ready to use. However, you can con-
figure some settings according to your preferences and application needs. These set-
tings include, but are not limited to, the following:

l Sequence and sync numbering

l Tool offset numbering

l Use of spaces in your NC file

l Job/shop info for your NC header

To find these settings, open your machine file in Code Expert and double-click the Con-
sumer icon in Machine Explorer.
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Most of the settings are grouped into two categories:

l Control Definition

l Output Settings

Select a category from the Category drop-down, and then click the + signs to see the
individual options. (See the following picture.) Some of these options (for example,
sequence number settings) are common to most controls; others are specific to indi-
vidual machines.
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These settings serve a variety of functions:

l Mimicking the control definition settings in non-Mill-Turn Mastercam

l Configuring toolpath modes and cycles

l Setting default values for Sync Manager and toolpath options

Most of these settings are self-explanatory, and you can easily configure them by
browsing the interface. After making changes, press [Ctrl+S] to save your machine
file.

Opening Code Expert in Multi-Stream View
Several settings in the machine file configure Code Expert Editor. Access these
options by opening the Consumer layer. For example, you can use Code Expert Editor
in either single-stream or multi-stream mode. To make multi-stream mode the
default, do the following:

1. Open the Consumer layer.

2. Select the Output Settings category.
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3. Open the NC Output group.

4. Select the Open post output in Multi-Stream view option.

Configuring the Find Extents Feature
The Find Extents feature in Code Expert scans your NC file and displays the minimum
and maximum values for each letter address. By default, Find Extents is set to scan X,
Y, Z, B, C, S and F. If you wish, you can edit the set of addresses that are scanned.
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1. Go to the NC Configuration category.

2. Open the Program group.

3. Enter the desired letter addresses in the list, separated by semi-colons ( ; ).

For example, if you add I;J;K; to the list, the next time you post, you will see
them in the Find Extents table.

Setting the Toolpath Directory
In non-Mill-Turn Mastercam, the toolpath directory setting is in the Machine Group
Properties dialog box, as shown below:
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In Mill-Turn, the setting in Machine Group Properties is only used to override the
default toolpath directory. The default toolpath directory (the one used for newly cre-
ated files) is a property of the machine file. To set it, follow these steps:

1. Open the machine file in Code Expert.

2. If necessary, open the Properties window.

3. In Machine Explorer, click the machine name.

4. In Properties, select the desired NC output Folder.

Mastercam will write your NC files for this machine to this folder.
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5. Select the desired Overwrite Mode.

You can choose whether Mastercam automatically overwrites NC files with the
same file name or prompts you to enter a different name.

This Overwrite Mode setting replaces the setting from the Posting dialog box
in non-Mill-Turn Mastercam.

6. Save the machine file.

Note: For more information on your machine’s settings and capabilities with
Mill-Turn, please refer to the application guide that comes packaged with each
machine. You can also access this document in Machine Explorer’s Docu-
mentation folder.
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Managing Machine Licenses
Before you can use a Mill-Turn machine, you must have a license for it. If you use
other Mastercam products, you are familiar with HASPs, the small device that plugs
into your USB port and verifies your Mastercam license.

Mill-Turn machines, however, use software licenses administered by a product named
CodeMeter. You can access CodeMeter from your System Tray, as shown in the pic-
ture below. Use CodeMeter to inspect or manage your Mill-Turn licenses.

Verifying that You Have the Proper License
Follow these steps to see what licenses are available on your workstation and to verify
their status:

1. Click the CodeMeter icon in the System Tray.

The CodeMeter Control Center opens. You should see a single item in the
License tab. This is the container that stores all of the Mill-Turn licenses
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installed on your system. The Status should tell you that the license is activ-
ated.

2. Click the WebAdmin button to inspect the individual licenses.

Your Web browser opens to the CodeMeter WebAdmin page, as shown in the
following image.
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3. Click the License Monitoring tab to see the licenses that are installed.

The example below shows this user's installed Mill-Turn licenses. If this user
had licenses for machines, they would be listed here, as well.
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Note: In Mastercam, if you try to open a machine for which you do not have a
license—or open a part file that uses such a machine—Mastercam displays an error
message.

Reactivating Disabled Licenses
If you have a license installed on your system, and you still receive a license message,
the license may have become disabled. To run properly, the CodeMeter application
needs to maintain a constant connection with your HASP. If this connection breaks,
your software licenses cannot be activated, and you will be unable to run Mill-Turn.

Common reasons this might happen include:

l You unplug your HASP before shutting down your workstation.

l You run on a NetHASP, and the network connection is broken.

l Your computer has gone into sleep or hibernation mode, and CodeMeter can
no longer detect the HASP.

If your CodeMeter licenses are invalid for any reason, the icon in the System Tray
changes from blue to red. To repair the license, follow these steps:

1. Make sure that your workstation is properly connected to the HASP.

2. Start CodeMeter by clicking its icon in the System Tray.

3. When CodeMeter starts, make sure your Mastercam MT license container is
visible.
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CodeMeter will tell you that the license is invalid, as shown in the picture for
the following step.

4. Click the Repair License button.

You should now be able to run Mill-Turn normally. Please contact your Reseller
if you still have problems.
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Working with Tools and Spindles

This lesson explains how tool and toolpath settings work together to produce
the proper NC output for your Mill-Turn machine’s lathe operations and
tools.

Lesson Goals
l Initial tool setup.

l Edit tool settings.

l Change insert orientation.

l Switch between LH and RH holders.

l Specify a tool's compensation point.

l Set up for left or right spindle.

l Setup for pinch turning.
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Initial Tool Setup
Tools for both upper and lower turrets should be defined so that they are oriented cor-
rectly for the intended turret at the tool change position, with the correct vertical or
horizontal orientation. These settings are stored in the Mastercam tool definition,
shown below.

When you first select the tool, it should look as it is oriented at the tool change regard-
less of which spindle you are working on. The position shown in the Toolpath para-
meters page will be different depending on whether the tool is in the B-axis head or a
lower turret.
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Editing Tool Settings
To review or edit the tool settings, follow these steps. (This general procedure is
informational only and not part of the tutorial.)

1. Right-click the tool in the tool selection window.

2. Choose Edit tool from the pop-up menu.

The Define Tool dialog box opens.

3. Click Setup Tool.

The Lathe Tool Setup dialog box opens.

4. Make changes to the tool settings, as needed.
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5. Click OK in the Lathe Tool Setup and Define Tool dialog boxes to finalize
your changes.

Note: When altering the tool definition settings, use the Draw Tool button to quickly
view the tool’s orientation.

Insert Up/Down and LH/RH Holders
When the tool is mounted at the tool change position, it can be in any of four ori-
entations, depending on whether it is mounted insert up or insert down, and whether
you are using a left-hand or right-hand holder. Any of these orientations is acceptable
with Mill-Turn; the correct choice depends on how you need the tool oriented when
you rotate it into its cutting position.

The tool preview window in Mastercam shows you how the tool is oriented. Notice in
the following picture that the insert color changes to show insert up (yellow) or insert
down (orange).

Left-hand holder, insert up

Left-hand holder, insert down

Right-hand holder, insert up

Right-hand holder, insert down

Changing Insert Orientation
To change the tool from insert up to insert down, do the following. (This general pro-
cedure is informational only and not part of the tutorial.)

1. Go to the Lathe Tool Setup dialog for the tool. (Click the tool in the operation,
and then click Setup Tool in the Define Tool dialog box.)

2. Toggle the Reverse tool setting.
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3. Change the Spindle Rotation direction.

Switching Between LH and RH Holders
To switch between left- and right-hand holders, do the following. (This general pro-
cedure is informational only and not part of the tutorial.)
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1. Go to the Define Tool dialog box. (Click the tool in the operation.)

2. Click the Draw Tool button.

For your verification, Mastercam displays the tool in its current configuration.

3. Press [Enter] to return to the Define Tool dialog box.

4. Select the Holders tab.

In the Style box, the holders are arranged in left/right pairs.
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5. Select the desired left- or right-hand holder.

6. Click the Draw Tool button to see the change, and then press [Enter] to return
to the Define Tool dialog box.

7. Click Setup Tool.

The Lathe Tool Setup dialog box opens.

8. Change the Spindle Rotation setting, and click OK.

The tool positions correctly for the operation.
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9. Click the Draw Tool button to see and verify your change, and then press
[Enter] to return to the Define Tool dialog box.

10. Click OK to dismiss the Define Tool dialog box.

Specifying the Tool’s Compensation Point
Depending on how you set up your tools on the machine, you may need to change the
compensation point Mastercam uses to calculate the toolpath. Do this in the Para-
meters tab of the Define Tool dialog box, as shown here. If your machine has a tool
eye (touch setter for turning tools) the standard setting is the first option.
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If you are using a tool that is being rotated in the B-axis head, and your toolpath is not
compensated as you expect, use the Cutting Direction options of the Tool Angle dialog
box (shown below) to specify how your tool was touched off on the machine. Click the
Tool Angle button on the Toolpath parameters tab to open this dialog box.

If you use this compensation method, you must touch off your tools differently at the
machine.
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Selecting the spindle and turret
In Mastercam, to specify which spindle and turret to use, you select an axis com-
bination. There is a specific axis combination for each possible combination of B-axis
head, left/right spindle, and turret. Even if your machine has only a B-axis head and
left spindle, Mastercam defines at least one axis combination.

Selecting an Axis Combination
The following general procedure demonstrates multiple axis combos. Follow these
steps. (This general procedure is informational only and not part of the tutorial.)

1. In the Toolpath parameters tab, click the Axis Combination button.

2. Select the desired turret/spindle combination. This picture shows the axis com-
bination set to use the lower turret on the left spindle.
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Setting Up Tools for Pinch Turning
When creating a pinch turn operation, the settings for the two tools must be correctly
coordinated. Mastercam cannot create the operation if the settings conflict. Follow
these guidelines.

l Insert direction—The insert directions for the two tools must be com-
plementary. For example, if the upper-turret tool is insert-down, then the
lower-turret tool needs to be insert-up. You can tell the insert direction from
the picture in the tool window. An orange insert means insert-down and a yel-
low insert means insert-up.

l Spindle direction—The spindle direction for the two tools must be the same.

l Tool holder—If the above two conditions are met and the toolpath is still not cre-
ated correctly, you might need to select a different tool holder.
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Reference Positions

Use reference positions (not to be confused with reference points) to specify
where to start and end operations. For example, you can move to the tool
change position between operations by selecting a reference position for the
first operation's retract and selecting the same reference position for the
second operation's starting point.

The following exercises demonstrate how to use and define reference pos-
itions in your Mill-Turn operations.

Lesson Goals
l Specify reference positions.

l Define reference positions.
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Exercise 1: Using Reference Positions
Mill-Turn machines come with standard reference positions already defined. You can
use these predefined reference positions without changing the machine or your part
files. Just select them as needed in Sync Manager, as the following exercise shows.

1. Load the file RefPositions into Mastercam, and save it as RefPositions-XX,
where XX is your initials. This ensures that you do not accidentally overwrite
the original file.

2. Select all operations in Toolpaths Manager.

3. Click the G1 button.

Sync Manager opens and displays the part’s data.

4. Click the small inverted triangle next to operation 1, Lathe Face.

A set of options appears in a drop-down box. One of these options is Refer-
ence Position.
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5. Open the drop-down menu for the Reference position option, and note that it
contains only one item, named Lower Reference Return.

This is the only reference position currently available for this operation on the
machine’s left spindle, lower turret.

6. Look at the reference position for operation 2, Lathe Rough.

Upper Reference Return is the only reference position currently available for
this operation on the machine’s left spindle, B-axis head.

7. Look at the reference position for operation 3, Lathe Finish.

You see two reference positions, (None) and Lower Reference Return.
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8. Expand the Lathe Finish operation, so that you can see the sub-operations. (If
you cannot see the “plus” icon for expanding the operation, make sure the
pane is scrolled all the way to the left.)

9. On operation 3’s Retract, change the Reference position setting from Lower
Reference Return to (None).

Note: Reference positions are available only on the operation and retract
nodes in the Operations pane.

10. Save the file.

Saving the file in the Sync Manager updates the part in Mastercam.
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11. Run Machine Simulation.

12. Set the view to Isometric.

13. Use your mouse wheel to zoom in on the chuck.

14. Click Run on the Simulation tab to run the simulation, and notice that the lower
turret does not retract to a reference position after completing the finish cut.
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This is because you set this retract’s reference position to (None).

15. In Sync Manager, change the reference position for the third operation’s
Retract back to Lower Reference Return.

16. Save the file, relaunch Machine Simulation, and click the Run button.

Now, after completing all cuts, the spindle retracts to the position specified by
the Lower Reference Return reference position.
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17. Close Machine Simulation.

Exercise 2: Creating Reference Positions
Although each machine file includes a set of predefined reference positions, you can
use the main Mastercam application to create your own. You might want a custom ref-
erence position, for example, to accommodate special part fixtures or tooling. Unlike
the predefined reference positions, custom reference positions are stored in the part
file, not the machine file.

The following exercise demonstrates how to define and use a custom reference pos-
ition. Continue with the file from the previous exercise.

1. In Mastercam’s Toolpaths Manager, click the Edit reference positions but-
ton.

The Machine Reference Position Manager opens.
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2. Right-click Lower Reference Return, and choose Duplicate selected ref-
erence position from the pop-up menu.

Mastercam creates a copy of the reference position.

3. Change the new reference position’s name to Alternate Lower Reference
Return, and set the Z2 Axis value to 500. Click OK to save your changes.

Now, Alternate Lower Reference Return, the reference point you just cre-
ated, is identical to Lower Reference Return, except for its name and Z2 Axis
value.
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4. Click the G1 button to update Sync Manager with the new reference position.

5. Change the reference position for operation 3’s Retract to the new Alternate
Lower Reference Return.

6. Save the file, and run the simulation.
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Now the turret retracts to a position 500 mm farther to the right, compared to
where it started at the original Lower Reference Return reference position.

7. Close Machine Simulation, Code Expert, and Mastercam.
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Configuration and Job Setup

Before you create toolpaths with Mastercam Mill-Turn, you must complete
configuration and setup tasks. These include choosing a machine and setting
the appropriate options for your job.

Lesson Goals
l Add a machine file.

l Select a machine file.

l Complete Job Setup.
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Adding a Machine File
Mill-Turn supports many types of machines, each having its own machine solution
(MACHINE file). To see how to add a machine, start Mastercam and perform the fol-
lowing steps.

Exercise 1: Adding Your Machine
1. If you have not already done so, place a copy of Generic Fanuc Mill-

Turn LTX.machine (also included with this tutorial) in your C:\User-
s\Public\Documents\shared mcam2018\Mill Turn\machines
directory.

2. On Mastercam’s Machine tab, choose Mill-Turn, Manage List.

The Machine Definition Menu Management dialog box displays.

3. For the purposes of the exercises in this tutorial, choose Generic Fanuc
Mill-Turn LTX.machine, and click Add.

The machine moves to the Machine Definition Menu Items box, which
means that it will now appear in Mastercam’s Machine Type, Mill-Turn sub-
menu.

4. Click OK to dismiss the Machine Definition Menu Management dialog box.
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Setting Up Your Job
You can now select the machine from the Machine, Mill-Turn drop-down menu.
When you do, Job Setup, in which you must define your job’s parameters, displays.
These parameters include the following:

l The Work Coordinate System (WCS) setting

l The spindle on which work will begin

l The type of work to be done (single piece or bar)

l The part geometry

l The stock definition

l The chuck jaw definitions

l The part stickout and pickoff positions

Exercise 2: Selecting a Machine
1. Load the part file TurningToolpaths, which is included with this tutorial.

Note: This part file is in Metric units. If your Mastercam system is set for Eng-
lish units, you will be asked about switching from English to Metric. Just click OK
to proceed.

The part’s geometry displays in Mastercam’s graphics window. However,
because no machine is assigned to the part, the Toolpaths Manager is empty.

2. Save the part file as TurningToolpaths_XX, where XX is your initials. This
ensures that you do not accidentally overwrite the original file.

3. From Mastercam’s Machine, Mill-Turn drop-down menu, choose the Gen-
eric Fanuc Mill-Turn LTX.machine file.
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Mastercam creates a new machine group, and then displays the Job Setup tab
of the Machine Group Properties dialog box.

Note: If Code Experts opens on top of Mastercam, minimize Code Expert. Do not
close it.

Completing Job Setup
The Job Setup tab contains the general parameters for your job. These parameters
are arranged in top-down fashion, providing a helpful work flow for successfully con-
figuring your job. In this section of the tutorial, you work through the parameter list,
setting up a continuous bar stock job on the left spindle. This job includes pickoff and
cutoff operations.

Exercise 3: Setting Setup Type and WCS
1. Select Setup Type in the list, and ensure that Initial Spindle is set to Left

spindle.

The Left spindle setting specifies that the job starts on the left spindle. If a
part transfer is required, the part moves from the left spindle to the right
spindle.
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2. Ensure that Continuous bar stock - Pickoff, Stock Pull, Cutoff is selected in
the drop-down list.

Mill-Turn includes options for continuous bar stock and single stock pieces.
Your selection determines the part handling operations you can create and the
options that are available in the Pickoff page.

3. Select the WCS page, and ensure that WCS is set to TOP.
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Note: In your production work, you can use the WCS setting to reorient parts
that are not aligned correctly for machining.

Exercise 4: Specifying Part Geometry
1. Select Part geometry from the list, and click the geometry selection arrow.

The dialog box minimizes so that you can access Mastercam’s graphics win-
dow.

2. Click anywhere on the part, and press [Enter].
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Mastercam returns to the Job Setup tab, with the part’s geometry selected.

Mastercam also enables the Delete previously created geometry and
Create Right Spindle Geometry options. The first ensures that geometry cre-
ated in previous operations (if you've previously run Setup) is removed from
the part. The second creates geometry for the opposite spindle, in this
instance, the right spindle.

3. Select the Create turn profile(s) option, and ensure that Spin is active.

The Create turn profile(s) option tells Mastercam to create turn-profile geo-
metry using either of the following methods: Spin rotates the part geometry
around an axis, generating the profile from the farthest extents of the spun
geometry. Slice slices the part geometry in the Lathe ZX (WCS XY) plane. The
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profile is limited to what the slice encounters and may not include the geo-
metry’s full extents. For example, bosses not in the slice plane will be unrep-
resented in the turn profile.

Exercise 5: Specifying Bar Stock Settings
1. Select Bar Stock in the job setup list, and ensure that Number of parts is set

to 1.

2. Set Extra stock for the outside diameter to 1.0 mm.

Note: The initial stock settings, such as diameter values, appear when a solid
has been selected as the part or stock model. This is not the case with wire-
frame geometry.
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3. Set extra stock for face and back to 2.0 mm.

Exercise 6: Setting Spindle and Chuck Parameters
1. In the job setup list, click Left Spindle, Toolplane origin Z.

2. Notice that the toolplane origin is on the part’s right face.

3. Choose StickOut in the Job Setup list.
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4. In the Part Stickout box, click the “target” button.

Mastercam minimizes the dialog box so that you can access the graphics win-
dow.

5. Click the part where shown in the following picture.
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The Machine Group Properties dialog box redisplays, and Chuck face is set
to 150.0.

6. In the job setup list, click Right Spindle, Toolplane origin Z.

7. Notice that the toolplane origin is on the part’s left face.
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Note: The jaw options that you see are based on the Stock type and other stock set-
tings. For example, you will not see ID jaw options unless an inner diameter has been
specified on the Bar stock page.

Exercise 7: Defining the Pickoff Operation
1. In the job setup list, select Pickoff.

2. In the Pickoff box, click the “target” button.

Mastercam minimizes the dialog box so that you can access the graphics win-
dow.

3. Click the part where shown in the following picture.
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The Machine Group Properties dialog box redisplays, and Distance from
chuck face is set to 93.75. This is where the right spindle will grip the part.

4. In the Cutoff box, set Cutoff width to 4.0 mm.

5. Click OK to close the Machine Group Properties dialog box.

6. Save the file as TurningToolpaths2_XX, where XX is your initials.
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Your job setup is now complete. In the next lesson, you create the toolpath operations
needed to face the part in the left spindle with the lower turret.
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Turning Toolpaths

In this lesson, you create toolpaths to cut the face and OD of a part with both
roughing and finishing operations. You program the initial operations on the
left spindle. You then transfer the part to the right spindle and cut the areas
that were inaccessible in the left spindle.

Lesson Goals
l Perform facing, using the left spindle and lower turret

l Perform roughing, using the left spindle and upper turret

l Perform finishing, using the left spindle and lower turret

l Perform part transfer from the left spindle to the right spindle, which
includes pickoff and cutoff operations

l Perform facing, using the right spindle and lower turret

l Perform pinch turn, using the right spindle, upper turret, and lower
turret
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Programming the Left Spindle
In this section, you create a facing toolpath. You also create roughing and finishing
operations for the part’s OD. You program these toolpaths on the left spindle, altern-
ating between the lower and upper turrets.

Continue with your part from the previous lesson. Alternatively, you can load the file
TurningToolpaths2, included with this tutorial. If you choose to load Turn-
ingToolpaths2, remember to save it as TurningToolpaths2_XX, where XX is
your initials.

Exercise 1: The Facing Toolpath
1. Click Mastercam’s Turning tab, and choose Face from the General toolpaths.

The Lathe Face dialog box appears. The tools displayed, however, are not
appropriate for the operation you will create.

2. Click the Axis Combination button.

The Axis Combination / Spindle Origin dialog box displays.

3. Select the Lower Left axis combination, and click OK.
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The Lathe Face dialog box now shows tools that are appropriate for the lower-
left axis combination.

4. Select the ROUGH FACE LEFT - 80 DEG tool (your tool may be in a different
position than the one shown).

5. Click the Face parameters tab.
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6. Activate the Lead In/Out checkbox.

7. Click OK to exit the dialog box.

Mastercam creates the facing toolpath based on your selected parameters,
and the operation appears in Toolpaths Manager.

Exercise 2: The Roughing Toolpath
1. Choose Rough from the General toolpaths.

The Chaining dialog box displays.
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2. Select the chain shown in the picture below, by clicking points 1 and 2.

3. Click OK to close the Chaining dialog box.

The Lathe Rough dialog box displays.

4. Click the Axis Combination button, ensure that the Upper Left axis com-
bination is selected, and click OK.

5. Choose the OD Left 55 deg tool.
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6. Click the Tool Angle button.

7. In the Tool Angle dialog box, set the angle to 90, and click OK.

8. Click OK to close the Lathe Rough dialog box.
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Mastercam creates the roughing toolpath, as shown below.

Exercise 3: The Finishing Toolpath
1. Choose Finish from the General toolpaths.

The Chaining dialog box displays.

2. Select the chain shown in the picture below, clicking points 1 and 2.
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3. Click OK to close the Chaining dialog box.

The Lathe Finish dialog box displays.

4. Ensure that the Axis Combination is set to Lower Left.

5. Select the OD FINISH RIGHT - 35 DEG tool.
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6. Click OK to close the Lathe Finish dialog box.

Mastercam creates the finishing toolpath.

7. Save the file as TurningToolpaths3-XX, where XX is your initials.

Exercise 4: Simulating the Toolpaths
To test your operations, you will now simulate the job in the Machine Simulation applic-
ation.

1. In Mastercam’s Toolpaths Manager, click Machine Group-1.

Mastercam selects all of the operations.

2. Click the G1 (Post) button.
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After a few moments, Code Expert displays Sync Manager. If you see the Prop-
erties pane, close it to free up space in the window.

3. In the Sync Manager tab, click the Launch button.

After a few moments, the Machine Simulation window displays, as shown in
the following picture.

4. In the Simulation ribbon, click Isometric.
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5. In the graphics window, place your mouse pointer over the left spindle, and use
your mouse wheel to zoom in closer to the part’s stock, as shown in the fol-
lowing picture.

6. In the Simulation tab, click the Run button.

7. Watch as Machine Simulation simulates the three operations you created.
Notice how the machine tries to make two cuts simultaneously, as seen in the
following picture.
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Note: Use the Simulation Run Speed slider to speed up or slow down the simulation
as needed.

Exercise 5: Synchronizing the Toolpaths
1. Close Machine Simulation.

You are now ready to do more work in Sync Manager.

2. In Sync Manager, click the plus signs (+) next to the operations in both the
upper and lower streams. Alternatively, to expand all operations, right-click in
either operation stream, and choose Expand All Operations.

Sync Manager expands the operations to display the sub-operations.
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3. Drag the right-hand edge of the Operations pane to the right, expanding the
pane until you can see more of the operations’ descriptions, as shown below.

4. Drag down the bottom edge of the pane, expanding the pane vertically.

5. Use your mouse to drag-and-drop the Lathe Face operation’s Retract to the
Lathe Rough operation’s Approach.
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You have now synchronized the end of the facing toolpath with the start of the
roughing toolpath. Sync Manager labels the sync point as Sync 1.

6. Drag the Lathe Rough operation’s Retract to the Lathe Finish operation’s
Approach.

Sync Manager labels the second sync point as Sync 2.
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You have now synchronized the end of the roughing toolpath with the start of
the finishing toolpath. Your upper and lower streams should now look like the
following picture.

At this point, the file’s status icon is yellow, which means that Mastercam must
be updated from Sync Manager. For more information on how Sync Manager
and Mastercam share data, please see Sync Manager and Mastercam
Interactions.

7. With the focus on the IOF file’s tab, choose File, Save.

Sync Manager writes the synchronized data back to Mastercam, and the status
icon returns to green.

8. Click the Launch button, and run the simulation again.
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Now the operations are synchronized. That is, they are guaranteed to run in
the correct order, without one operation overlapping another.

9. Close Machine Simulation.

10. Back in Mastercam (not Sync Manager), save the part as Turn-
ingToolpaths4-XX, where XX is your initials.

The Part Handling Operations
You now must transfer the part from the left spindle to the right, so that you can cre-
ate the toolpaths to complete the job. To do this, you program pickoff, cutoff, or trans-
fer operations that leave the part clamped in the right chuck, ready for cutting.

Exercise 6: Creating Part Handling Operations
1. From Mastercam’s Turning tab, choose Part Handling, Pickoff/Cutoff.

The Pickoff, Stock Pull, Cutoff dialog box displays.

2. Verify that the Strategy is set to Pickoff, Stock Pull, Cutoff (Upper Turret),
as shown in the picture below.

The Strategy selection (A) determines which operations appear in the Oper-
ations list (B).
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3. Click OK to accept the default settings for your part handling strategy.

Mastercam Mill-Turn creates the requested set of operations, as seen in the
picture below.
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Exercise 7: Simulating the New Operations
1. In Toolpaths Manager, click Machine Group-1.

Mastercam selects all of the operations.

2. Click the G1 button.

Mastercam sends the new data to Sync Manager, and Sync Manager displays
in Code Expert’s window.

3. Sync operation 4 Turret Park, Lower Park Left to operation 5 Lathe Point,
Approach, as shown in the picture below.

Sync Manager creates a sync point labeled Sync 3. You have now syn-
chronized the end of the finishing operation with the right spindle approach.
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4. Save the file back to Mastercam, and then click the Launch button.

In a few moments, Machine Simulation displays.

5. Rotate the graphics window so that you can see both spindles. (See the picture
below.) To do this, place your mouse pointer over the graphics window, hold
down your left mouse button, and drag the mouse.

Mastercam Mill-Turn Tutorial — 8: Turning Toolpaths



6. Use your mouse to zoom in on the two spindles.

Now you can see the simulation more clearly.

7. Click the Run button.

Machine Simulation simulates the job’s operations. When the simulation com-
pletes, the right chuck will be holding the part.

8. Close Machine Simulation.

9. In Mastercam, save the part as TurningToolpaths5-XX, where XX is your
initials.
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Programming the Right Spindle
Your part is now in the right spindle, and you can create the toolpaths to complete the
part. For the following exercise, continue with your part from the previous section.

Exercise 8: The Facing Toolpath, Right Spindle
1. In Mastercam, select the Machine Group-1.Right viewsheet tab.

The graphics window now displays the right spindle.

2. From Mastercam’s Turning tab, choose General, Face.

The Lathe Face dialog box displays.

3. Click the Axis Combination button.

The Axis Combination / Spindle Origin dialog box displays.
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4. Select the Lower Right axis combination, and click OK.

The Lathe Face dialog box now shows tools that are appropriate for the lower-
right axis combination.

5. Select the Rough Face Right / 80 Deg tool.
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6. Click the Face parameters tab.

7. Ensure that the Lead In/Out checkbox is selected, and then click the Lead
In/Out button.

The Lead In/Out dialog box displays.

8. Click the Lead out tab.

9. Change Angle to 180.

The tool will now exit away from the part, rather than toward it.
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10. Click OK to exit the Lead In/Out dialog box.

11. Click the Finish Z button.

12. Click the left face of the part, as shown in the picture below.
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13. Click OK to exit the dialog box.

Mastercam creates the facing toolpath based on your selected parameters,
and the operation appears in Toolpaths Manager. (Your tool numbers may
vary.)

Exercise 9: The Roughing Toolpath, Right Spindle
1. From Mastercam’s Turning tab, choose General, Rough.

The Chaining dialog box displays.

2. Select the chain shown in the following picture, by clicking points 1 and 2.
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3. Choose OK to close the Chaining dialog box.

The Lathe Rough dialog box displays.

4. Click the Axis Combination button.

The Axis Combination / Spindle Origin dialog box displays.

5. Ensure that the Upper Right axis combination is selected, and click OK.

6. Choose the OD ROUGH RIGHT - 80 DEG tool.
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7. Click the Tool Angle button.

The Tool Angle dialog box appears.

8. Set Tool Angle to 90, and click OK.

9. Click OK to close the Lathe Rough dialog box.

Mastercam creates the roughing toolpath, as shown in the following picture.

Mastercam Mill-Turn Tutorial — 8: Turning Toolpaths



Exercise 10: The Pinch-Turn Toolpath
1. From Mastercam’s Turning tab, choose General, Pinch Turn.

The Pinch Turn Associated dialog box opens.

2. Click the Axis Combination button.

The Axis Combination / Spindle Origin dialog box opens.
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3. Set the Axis Combination to Lower Right, and click OK.

4. Choose the OD RIGHT 55 DEG tool.

5. Click the Pinch turn tab.

The Pinch Turn settings appear in the dialog box.

6. In the operation list, select the Lathe Rough operation in Toolpath Group-2.

This is the operation Mastercam will use to generate the pair of operations
that make up the Pinch Turn toolpath.
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7. Click OK to exit the dialog box.

Mastercam creates the Pinch Turn toolpath.

Exercise 11: Synchronizing the Toolpaths
1. In Toolpaths Manager, click Select all operations.

Mastercam selects all of the operations.

2. Click the G1 button.

After a few moments, Code Expert displays Sync Manager with the updated
part data.

3. In the Upper Stream list, scroll down to operation 18 Turret Park, and click
the plus (+) to show the sub-operations.

4. In the Lower Stream list, open operation 19 Turret Park.

5. Drag-and-drop from operation 18 Turret Park, Upper Reference Return to
operation 19 Turret Park, Lower Reference Return, as shown in the picture
that follows.

Mastercam Mill-Turn Tutorial — 8: Turning Toolpaths

122



123

You have now synchronized the end of the part handling operations with the
turret park operation.

6. Drag operation 20’s Retract to operation 21’s Approach.

Sync Manager creates the sync point.

7. Choose File, Save.

Sync Manager writes the synchronized data back to Mastercam.

8. Click the Launch button, and run the simulation.
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All operations are synchronized.

9. Close Machine Simulation.

10. Back in Mastercam (not Sync Manager), save the part as TurningToolp-
aths6-XX, where XX is your initials.

11. Close Mastercam and Code Expert.
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Milling Toolpaths

These exercises step through basic C- and Y-axis toolpathing using a par-
tially programmed sample file. For simplicity, you import toolpaths from an
existing file.

Lesson Goals
l Set up the part.

l Import milling operations.

l Complete the pocket operation.

l Complete the facing operation.

l Complete the rough contour operation.

l Complete the finish contour operation.
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Exercise 1: Setting Up the Part
1. Launch Mastercam.

2. Open the file MillToolpaths, which is included with this tutorial, and if the
System Configuration dialog box displays, click OK to switch system units.

In Toolpaths Manager, you can see that four lathe operations are already pro-
grammed (see the picture below). To start the C- and Y-axis milling examples, you will
import operations from a sample part.

Exercise 2: Importing the Milling Operations
1. Right-click in Toolpaths Manager, and select Import.

The Import Toolpath Operations dialog box appears.
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2. Click the Select Operations File button.

Note: To see the file when browsing, you must change the file extension filter
from Mastercam Operation Files to Mastercam Files.

3. Browse to and open the file FixSyncs, which is included with this tutorial.

The operations contained in the selected file appear in the Import Toolpath
Operations dialog box.

4. Select operations 5 through 8 (hold down [Shift] to select multiple items), and
click the Import Operations button (the one that looks like a plus sign).
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5. Click Done to close the Import Toolpath Operations dialog box.

After the import, Toolpaths Manager contains the operations.

6. In your Windows Start menu, go to All Programs, Mastercam 2018,
Advanced Configuration.

The Mastercam Advanced Configuration dialog box opens.

7. Select the Backplot properties page, and disable the Classic Backplot entry,
as shown in the following picture. Then click OK.

Mastercam will now backplot and verify with Mastercam Simulator.
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Exercise 3: Completing the Pocket Operation
1. Click the Parameters icon in operation 5.

The 2D Toolpaths - Pocket dialog box displays.

2. Verify that the Toolpath Type is set to Pocket.
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3. Click the Select chains button.

The Chain Manager dialog box appears.

4. Right-click in the dialog box, and choose Add chain from the pop-up menu.

The Chaining dialog box appears.

5. Chain the rectangle shown below, and click OK in the Chaining and Chain
Manager dialog boxes.
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6. Select Tool, and then verify that the tool is a ½-inch flat endmill.

7. On the Setup page, ensure that Y-Axis Cross and the Left Spindle / B-Axis
Head axis combination are selected.
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Note: Because there is no existing toolplane for the selected geometry,
Mastercam automatically creates the proper plane based on the selected geo-
metry, the operation orientation, and axis combo. The display at the bottom of
the dialog box tells you the name of the new plane.

8. Click OK to close the 2D Toolpaths - Pocket dialog box.

9. Click Regenerate all selected operations.

Mastercam regenerates the pocket operation.

10. Select operation 5’s Toolpath icon in the Toolpaths Manager.

The Mastercam Simulator window opens.
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11. In the Home tab’s Visibility group, ensure that Tool and Workpiece are selec-
ted.

Mastercam Simulator will now show the tool and the workpiece in its graphics
area.

12. On the View tab, click Isometric.

The view changes to the isometric orientation. Note that the view in Master-
cam also changes to isometric.

13. Click the Play button to run backplot.
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Mastercam backplots the operation, as shown in the second picture that fol-
lows.

14. Close Machine Simulation.

Exercise 4: Completing the Facing Operation
Next, you finish the short wall in back of the pocket.

1. Click operation 6’s Parameters icon.

The 2D Toolpaths - Contour dialog box displays.
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2. Ensure that Toolpath Type is set to Contour.

3. Click the Select chains button.

Chain Manager appears.

4. Right-click, and choose Add chain.

The Chaining dialog box appears.
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5. In the Chaining dialog box, choose the Single button, and then select the line
at the base of the wall, as shown in the second following picture.

6. Click OK in both the Chaining and Chain Manager dialog boxes.
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7. On the Setup page, select Y-Axis Cross, Left Spindle / B-Axis Head, and
Top, as shown below.

8. Click OK to close the 2D Toolpaths - Contour dialog box.

9. Click Regenerate all selected operations.

Mastercam regenerates the operation.

10. Select operation 6’s Toolpath icon, and backplot the operation in isometric
view, as shown below.
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11. Close Mastercam Simulator.

Exercise 5: Completing the Rough Contour Operation
Next, you rough out the triangular section at the front of the part.

1. Re-chain geometry for operation 7 – Contour (3D) as shown here.

2. Set Toolpath Type to Contour, and for Tool, select the ½-inch flat endmill.
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3. On the Setup page, select C-Axis Face and the Left Spindle / B-Axis Head
axis combo.

4. Regen the operation, and backplot it.

5. Close Machine Simulation.

Exercise 6: Completing the Finish Contour Operation
You next finish the triangular section at the front of the part.

1. Re-chain geometry for operation 8 – Contour (2D) as shown here. (Select the
same contour as in the previous rough operation. Tip: Use the Last button in
the chaining dialog to select the last chain selected in the previous toolpath.”)

2. Set ToolpathType to Contour.

3. On the Setup page, select C-Axis Face and the Left Spindle / B-Axis Head
axis combo.

4. Click OK to close the 2D Toolpaths - Contour dialog box.

5. Regen the operation, and backplot it.

6. In Mastercam, save the part as MillToolpaths2_XX, where XX is your ini-
tials.

7. Close the Simulation, Code Expert, and Mastercam windows.
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More about Sync Manager

Sync Manager lets you create sync points for multi-stream machines and cre-
ate custom job setups that ensure valid output. You have already used Sync
Manager in previous lessons. This lesson demonstrates additional features
you might have not yet discovered.

Lesson Goals
l Explore Sync Manager's window.

l Customize the display.

l Customize the operation settings.

l Use the Timeline.

l Understand Sync Manager and Mastercam interactions.
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Sync Manager's Window
Sync Manager’s window has six main areas. Refer to the following picture as you work
through the procedures in this lesson.

Ribbon Machine Explorer

Operations pane Properties grid

Graphics window Timeline
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Exercise 1: Customizing the Display
You can easily modify Sync Manager’s display to suit your needs. Try the following pro-
cedure to discover some common features.

1. In Mastercam, load the part file named SyncManager, which is included with
this tutorial. Click OK to change units if asked.

Notice that Toolpaths Manager contains a machine group for a Generic Fanuc
MT Machine. Notice also that the toolpath group contains facing, roughing, and
finishing toolpaths for the part displayed in the graphics window.

2. Save the file as SyncManager_XX, where XX is your initials.

3. Click the G1 button.

In a few moments, Sync Manager appears in the Code Expert window.

4. If you have Machine Explorer and the Properties grid open, close them so that
you can see more of the part.

5. Click the small arrow in the Timeline’s upper-right corner, and choose Auto
Hide.

The Timeline minimizes to a tab.
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6. In the Sync Manager tab, experiment with the checkboxes in the Show group
to toggle display elements on and off.

7. Click the View tab.

Mastercam Mill-Turn Tutorial — 10: More about Sync Manager

144



145

8. Click the Fit button.

The geometry zooms to fit the graphics window.

9. Click the view buttons to see the part from different angles.

Exercise 2: Customizing Operation Settings
You can set options for individual parameters by clicking small inverted triangles in
the Operations pane. Try the following procedure to see how this works.

1. With your mouse, drag the right-hand edge of the Operations pane to
increase its width.
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2. Click the plus signs (+) next to the operations in the Operations pane.

Sync Manager expands the operations, as shown below.

3. Go to the View tab, and click Properties.

The Properties grid appears.
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4. Click OD Left 55 deg in the Operations pane.

Information about the selected item appears in the Properties grid, as shown
in the following picture.

5. Back in the Operations pane, click the small inverted triangle to the right of
Lathe Rough.

A small box appears into which you can enter option values.
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6. Change the Coolant value to Strategy1, and then click outside of the box to
accept your change.

The option’s value in the Properties grid also changes. You can edit your oper-
ations in either the Operations pane or the Properties grid.

7. Save the file in Sync Manager and then in Mastercam.

Exercise 3: Using the Timeline
1. Click the Timeline tab in Code Expert’s lower-left corner.

The Timeline displays.
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2. In the Timeline’s upper-right corner, click the pin icon.

The Timeline’s Auto Hide option is now off, and the Timeline no longer min-
imizes to a tab.

The Timeline displays the operations horizontally instead of vertically, as they
are displayed in the Operations pane.

3. If necessary, in the Timeline’s lower-left corner, drag the zoom slider all the
way to the left.

You should see the three operations and two red lines. (You may need to max-
imize the Sync Manager window.) The red lines are the sync points created in
the Operations pane.
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4. Hover your mouse over a sync point in the Timeline.

Sync Manager displays a tooltip for the sync and outlines the equivalent sync
point in the Operations pane, as shown in the following image.

5. Close Code Expert, without saving changes you may have made to the file.
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Exercise 4: Sync Manager and Mastercam Interactions
Because Sync Manager and Mastercam share data, their interactions are tightly con-
trolled. When a part is open in both, you can access either application freely only when
the data in both is up to date.

Mastercam is the master application with respect to Sync Manager; the part data in
Mastercam represents the current state of the part. Sync Manager uses a working
copy of that data. When you save data from Sync Manager, you are updating the part
file in Mastercam. To see how these interactions work, try the following exercise.

Exercise 5: Changing Data in Sync Manager
1. Load the file SyncManager2 (provided with this tutorial) into Mastercam, and

save it as SyncManager2_XX, where XX is your initials.

Mastercam not only loads the part, but also starts the Code Expert application.
Note that Code Expert is not yet displaying data for the part you loaded.

2. In Mastercam’s Toolpaths Manager, select all operations, and then click the
G1 button.

Sync Manager opens the part. At this point, you can access both Mastercam
and Sync Manager because both applications have a clean operation set.

3. In Sync Manager, notice the green circle on the file’s tab.

Green indicates that Mastercam’s and Sync Manager’s data sets match.
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4. In Sync Manager, expand the Lathe Rough and Lathe Face operations, as
shown below.

Note: You can use the Connect Stream List Display button (shown below) to
lock together the lists, operations, and sync points so that they remain hori-
zontally aligned.

5. Right-click on a Sync 1 sync point, and choose Delete Sync Group from the
pop-up menu.

Sync Manager removes the pair of sync points.

Mastercam Mill-Turn Tutorial — 10: More about Sync Manager

152



153

6. Notice that the status indicator is now yellow, which means Mastercam’s and
Sync Manager’s data sets no longer match.

7. Try to select something in the Mastercam window.

Sync Manager retains control, disabling access to Mastercam. You cannot use
Mastercam because the loaded part does not yet contain the changes you
made in Sync Manager.

8. In Sync Manager, click the Save button.

Sync Manager’s status indicator turns green.
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9. Try to select something in the Mastercam window.

Sync Manager lets you access Mastercam because its data is now up to date.

Exercise 6: Changing Data in Mastercam
1. In Mastercam, click the Geometry icon in the Lathe Rough operation, and

delete the chain.

Mastercam marks the operation as dirty.
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2. Notice that Sync Manager’s status icon has changed to a lock.

The lock indicates that the changed part in Mastercam does not match the
data in Sync Manager.

3. Rechain the geometry (select Geometry, right-click in the Chain Manager dia-
log, and choose Add chain), clicking at the points shown below.

4. Click the Regenerate all selected operations button.

Mastercam regenerates the operation, resolving its dirty state.

5. Select all operations, and then click the G1 button.

Mastercam sends the updated part data to Sync Manager, whose status indic-
ator again shows green.
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6. In Mastercam, select File, New, and, when prompted, choose Don't Save.

Sync Manager’s status indicator shows red, which indicates that Mastercam
and Sync Manager are no longer linked.

7. Close all windows.

The table below describes Sync Manager’s status icons.

Sync Manager’s data matches
Mastercam’s data.

Sync Manager needs to be
rerun from Mastercam.

Changes in Sync Manager
need to be saved.

Sync Manager and Master-
cam are disconnected.
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More about Machine Simulation

Use Machine Simulation to verify your toolpaths, watching as a graphical rep-
resentation of the machine cuts the part. Using Machine Simulation helps
you find problems before the actual machining. (For more information about
Machine Simulation, please read the Machine Simulation tutorial, available
from your Reseller or the Mastercam website.)

Lesson Goals
l Start machine simulation.

l Run a simulation.

l Manipulate a simulation.
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Machine Simulator's Window
The Machine Simulation window has the main areas shown below. Refer to this illus-
tration as you work through the procedures in this lesson.

Quick Access Toolbar Data panes

Ribbon Progress slider

Graphics window
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Exercise 1: Starting Machine Simulation
1. In Mastercam, open the file MachineSimulation, which is included with

this tutorial. Then save the file as MachineSimulation-XX, where XX is
your initials.

Mastercam’s window should look similar to the following picture.

2. In Toolpaths Manager, click the Select all operations button.

3. Click the G1 button.

Sync Manager opens with the part’s data loaded. (Note that you may or may
not see the Machine Explorer and Properties panes, depending on the state
of the application when you last closed it.)

4. In Sync Manager, click the Launch button.
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The Machine Simulation window appears, as shown in the picture below.

Note: If you do not see the tabbed panes on the right side of the window, you
can display them by choosing Docking Panes options from the View tab. The
following exercises require you to display the Move List.

Exercise 2: Running a Simulation
1. Place your mouse over the graphics area, and move your mouse wheel.

The view zooms in or out, depending on the direction you spin the wheel.
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2. On the Simulation tab, in the Views group, click the Fit button.

Machine Simulation zooms the graphics window to exactly display its contents.

3. Click the Run button.

Machine Simulation simulates the operations in your part. As it does, the Move
List displays the running code, as shown below. (If you do not see the Move
List, choose View, Move List.)

4. In the Visibility group, click the Machine Housing button.
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The machine housing becomes transparent, as shown in the following picture.

5. Click the Machine Housing button again.

Machine Simulation removes the machine housing from the display. You can
choose a specific display state (Show, Transparent, or Hide) by clicking the
small arrow below a component’s button and selecting the state from the drop-
down menu.
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6. In the graphics window, place your mouse pointer over the left spindle, and use
your mouse wheel to zoom in closer, as shown in the following picture.

7. Drag the simulation speed slider to the left, approximately to the location
shown.
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Now when you next start the simulation, it will run slower than it did the first
time.

8. Click the Restart button.

Machine Simulation resets the operations to the beginning.

9. Click the Run button.

Machine Simulation simulates the operations with your new settings.

10. Drag the Progress slider in the Progress window to move backward and for-
ward through the simulation.
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As you drag the slider, notice how the Move List updates to show the current
operation and move. (If you do not see the slider, increase the size of the Pro-
gress area.)

11. Close the Machine Simulation window. You do not need to save the part.

Mastercam Mill-Turn Tutorial — 11: More about Machine Simulation



166

Mastercam Mill-Turn Tutorial



167

Posting

After you have created your operations and verified them in Machine Sim-
ulation, you are ready to post the part. This process creates the program (G-
code) that you send to your machine control to cut the part.

Lesson Goals
l Post a part.

l Use editing functions.

l Use syncs and tools functions.

l Use the right-click menu.

l Send NC code to a control.

12



The Editor's Window
When you post a part, Code Expert opens the resulting G-code in its editor. The editor
window has the main areas shown below. Refer to this illustration as you work through
the procedures in this lesson.

Quick Access Toolbar Machine Explorer

Ribbon Properties grid

Code pane

Mastercam Mill-Turn Tutorial — 12: Posting
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Exercise 1: Posting a Part
1. Load the file PostingExample into Mastercam, and select all operations in

Toolpaths Manager.

2. Click the G1 button.

Sync Manager opens and displays the part’s data.

3. In Sync Manager, click the Post button.

Sync Manager processes the part, and opens the resulting G-code file into
Code Expert’s Editor.

Note that the code is merged into a single stream, with the code for both tur-
rets shown in the same pane.
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4. In the Utilities group, click Multi-Stream, and then click OK in the dialog box
that displays.
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Code Expert divides the code into two streams, with the upper turret on the left
and the lower turret on the right.

Exercise 2: Using the Editing Functions
1. Click NC Configuration.

The NC Configuration dialog box opens.

2. Click the Block Numbering tab.

The Block Numbering page opens.

3. Change Starting number and Increment to 10, and click OK.
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4. In the Editing group, click Insert Block Numbers.

The Editor adds block numbers to the code (see the image below) based on the
settings you specified in the Block Numbering page.

5. Click Remove Block Numbers.

The Editor removes the block numbers from the code.
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6. Click Remove Comments.

The Editor removes all comments from the active stream.

7. On your keyboard, press [Ctrl+Z].

The editor undoes the Remove Comments command.

Exercise 3: Using the Syncs and Tools Functions
1. Click in the upper turret stream (the left-hand stream), and then click Remove

Comments.

Code Expert removes comments from the stream so that the following step in
this tutorial does not find sync codes in non-code lines.
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2. In the Syncs group, click First.

The editor jumps to the first synchronization code in the file.

3. Click Next three times.

The editor shows the next synchronization code. (In this example, you click
three times to skip past two occurrences of Pn that are not actually sync
codes.)
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4. In the Tools group, click First.

The editor jumps to the first tool change in the stream.

Exercise 4: Using the Right-Click Menu
1. Highlight a line of code, right-click the line, and choose Lowercase from the

pop-up menu.

The editor changes the selected text to lowercase, as shown below.
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2. Right-click anywhere in the code, and select Copy File Path.

The editor places the active file’s full path into the Clipboard.

3. Place the text cursor where you want to insert the file’s path, and press
[Ctrl+V] to paste the file path into your code.

Exercise 5: Sending the NC Code to Your Control
1. Click the PostingExample-1.iof tab, and then click the Post button to post the

part. (If you are asked to save changes, click No.)

Sync Manager regenerates the NC file.

2. Click the File tab.

The file commands display.
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3. Click Options.

The Application Options dialog box appears.

4. Open the option group Editor, NC, Communications.

The communications options appear in the dialog box’s right pane.
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5. Set the communications options appropriately for your machine control. (If you
are unsure, leave them set to the defaults.)

6. Click OK to close the Application Options dialog box.

7. On the NC Functions tab, click the Send (not Send File) button.
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Code Expert sends the G-code file to your machine control.

Note: For more information on your machine’s settings and capabilities with
Mill-Turn, please refer to the application guide that comes packaged with each
machine.

8. Close all windows.
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Loading Multi-Station Tool Locators

Multi-station tool locators (see images below) offer extensive flexibility for
your machine setup. The examples in this appendix provide an overview of
loading tool locators onto a machine’s turrets, as well as loading tools into
the locators. The complete sample program demonstrates many tool locator
and tool combinations.

Exercise 1: Loading the Part and Processing the
Toolpaths

1. Copy the machine file Generic Fanuc Mill-Turn TT.ma-
chine into your C:\Users\Public\Documents\shared

13



Mcam2017\Mill Turn\machines folder.

You use this twin turret machine for the exercises that follow.

2. Open the file Multi-Station Locators.

The file is included with this tutorial and contains many operations that require
tools be loaded into turrets with multi-station tool locators. After loading the
file, Mastercam should look like the following image:

3. In Toolpaths Manager, click Machine Group-1 to select all of the operations.

If you want to see the operations, click the plus signs in the list to expand each
group.

4. Click the Post selected operations button.

Mastercam attempts to process the operations, but generates tool-loading
errors. These errors must be addressed before you can continue.
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5. Click the Cancel button to dismiss the IOF Generation Message Log dialog box.

The Tool Setup Manager appears, showing the tools that Mastercam loaded
into the upper and lower turrets.

6. Right-click the upper turret in the Machine tooling setup list, and choose
Remove all children from the menu that appears.

Mastercam removes all tool locators and tools from the upper turret.
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7. Right-click the lower turret in the Machine tooling setup list, and choose
Remove all children from the menu that appears.

Mastercam removes all tool locators and tools from the lower turret. Both tur-
rets are now empty.

Exercise 2: Loading a Tool Locator and Tool
1. From the Tool Locators pane, drag the 7.076.328 - UT - 4 Station - 20mm

Cross Turning- HIPM - LPIU - RPIU tool locator to Index 1 on the upper tur-
ret.

Mastercam adds the tool locator to the turret.
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2. In the Machine tooling setup list, right-click the upper turret, and select View
component and all children.

Mastercam displays the components in the graphics window.

3. Rotate the components to the view shown below. Note the four locations for
tools. You load those tools in the next steps.

4. Press [Enter] to return to the Tool Setup Manager.
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5. From the Tools in the machine group list, drag the tool T01 - OD ROUGH
LEFT - 80 DEG to the location Left - Primary - Insert Up.

6. Right-click the upper turret, and choose View component and all children,
as you did in Step 2.

Mastercam displays the components in the graphics window.

7. Rotate the components so that you can see the tool loaded into the tool loc-
ator.
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8. Press [Enter] to return to the Tool Setup Manager.

Exercise 3: Loading the Remaining Tools in the Tool Locator
1. From the Tools in the machine group list, drag the tool T01 - OD ROUGH

RIGHT - 80 DEG to the location Right - Primary - Insert Up.

2. Drag the tool T24 - OD FINISH LEFT - 35 DEG to the location Left - Half
Index Primary Minus - Insert Up.

3. Drag the tool T24 - OD FINISH RIGHT - 35 DEG to the location Right - Half
Index Primary Minus - Insert Up.

The tool locator is now fully loaded.

4. Right-click the upper turret, and choose View component and all children.

5. Rotate the components so that you can see the four tools loaded into the tool
locator.
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6. Press [Enter] to return to the Tool Setup Manager.

Exercise 4: Loading the Second Tool Locator and Live Mill Tools
1. From the Tool Locators pane, drag the 7.077.128 - UT - 2 Station - ER16 Live

Face - Offset Left tool locator to Index 2 on the upper turret.

Mastercam adds the tool locator to the turret.

2. In the Machine tooling setup list, right-click the upper turret, and select View
component and all children.

Mastercam displays the components in the graphics window.

3. Rotate the components to the view shown below. Note the new tool locator for
live tooling.
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4. Press [Enter] to return to the Tool Setup Manager.

5. In the Tools in the machine group list, locate the 8MM FLAT ENDMILL tools.

In the list, these tools’ descriptions look identical.
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6. Hover your mouse pointer over the first 8MM FLAT ENDMILL.

A tooltip describes this tool’s orientation as Face right.

7. Drag the right-facing 8MM FLAT ENDMILL to the location Right - Live Tool.

8. Drag the other 8MM FLAT ENDMILL (left facing) to the location Left - Live
Tool.

9. In the Machine tooling setup list, right-click the upper turret, and select View
component and all children.

Mastercam displays the components in the graphics window.

10. Rotate the components to the view shown below, and note the two live tools for
milling.
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11. Press [Enter] to return to the Tool Setup Manager.

This tutorial includes the completed file, Multi-Station Locators - Com-
plete. You can load this file if you wish to see complete machine tooling setup.

Exercise 5: Simulating the Operations
Before continuing with this part of the tutorial, load the complete file Multi-Sta-
tion Locators - Complete. Do not save changes to the previous file.

1. In Toolpaths Manager, click Machine Group-1 to select all of the operations.

2. Click the Post selected operations button.

Mastercam processes the operations and opens the part in Sync Manager, as
shown here:
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3. Click the Launch button to start Machine Simulation.

4. If necessary, click Machine Housing twice to hide the machine’s housing.

5. Rotate the view so that you can easily see the part stock and the turrets.
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6. Click Run to watch the machine cut the part, paying special attention to the tur-
rets and their tool locators. As the simulation runs, adjust the view by panning,
rotating, and zooming so that you can see each operation clearly.
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Note: When the machining gets to operation 54, the simulation will crash, dis-
playing the dialog box shown below. This crash is because the tap tool is larger
than the hole, as it should be. To prevent the simulation from constantly stop-
ping, click Do not show again in the dialog box, and select for this pair in
this simulation from the drop-down. Now the simulation will ignore further
crashes between this tool and the workpiece.
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Conclusion

Congratulations! You have completed the MastercamMill-Turn Tutorial tutorial! Now
that you have mastered the skills in this tutorial, explore Mastercam's other features
and functions.

You may be interested in other tutorials that we offer. Mastercam tutorials are being
constantly developed, and we will add more as we complete them. Visit our website,
or select Help, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful doc-
uments for your version of software in the Documentation folder of your
Mastercam 2018 installation.

l Mastercam Help—Access Mastercam Help by selecting Help, Contents from
Mastercam's File tab or by pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your local Mastercam Reseller can help with most ques-
tions about Mastercam.

l Technical Support—Our Technical Support department (860-875-5006 or
support@mastercam.com) is open Monday through Friday from 8:00 a.m. to
5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users
become familiar with basic Mastercam features and functions. Visit our web-
site, or select Help, Tutorials from Mastercam's File tab to see the latest pub-
lications.

l Mastercam University—Mastercam University, an affordable online learning
platform, gives you 24/7 access to Mastercam training materials. Take
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advantage of more than 180 videos to master skills at your own pace and help
prepare for Mastercam Certification. For more information on Mastercam
University, please contact your Authorized Mastercam Reseller, visit
www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find a wealth of information at www.-
mastercam.com. For tech tips and the latest Mastercam news, follow us on
Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam).
Visit our YouTube channel to see Mastercam in action
(www.youtube.com/user/MastercamCadCam)! Registered users can search for
information or ask questions on the Mastercam Web forum,
forum.mastercam.com, or use the knowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercam documentation, contact the Technical
Documentation department by email at techdocs@mastercam.com.
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